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Creating a Hyperlink in PowerPoint 2000 
By: Carole L. Colburn 

 
Hyperlinks are used in slides to turn text, graphics, and pictures or just about anything else, into a 
“hot” link. They are used to take you from one spot to another. This can be to another location 
altogether (as in a web page) or just to another location within the same slide show.  
 
To insert a hyperlink: 
 

1. Select the test, object or picture that you want to start with.  

2. You can click the Hyperlink Button on the Standard Toolbar or click the Insert menu, 

scroll down to Hyperlink and then click again. This will open the Insert Hyperlink 

dialog box. 

 

 
 

3. The text or object that you selected will appear in the “Text to Display” field. If you want 

the link to take you to a different file or a web page, type the URL (web address) or the 

file path in the “Type the file or web page name:” field.  



   

   
  

4. If you want the link to go to some other place in the same document, then click the “Place 

in the Document” button. 

5. Next, select the slide (from within the slide show) that you want the link to go to.  

6. Click the OK button. 

 

 
 
7. To remove a link, click the “Remove Link” button. 
 
 
 
 

Back to Top of Page 
 
FYI: The Staff Development Lab is now up and running and open for business. The 
new lab is located just next to “Suite E” in the administrative wing of the 
Freshman Campus. It is fully equipped with 28 wireless laptop computers, 2 
desktop stations with two scanners, and one teacher station, connected to the 
LCD Projector and Smart Board. In addition, a printer is network connected and 
ready to use in the back of the room. While the priority for use of this room and 
equipment is for staff development, teachers at the Freshman Campus may also 
check-out the laptops for use in their own rooms. If you are interested in 
scheduling the staff development lab and/or the computers, please contact either 
Carole Colburn (colburnc@howellschools.com) or Kim Blair (blairk@howellschools.com).  

 

mailto:colburnc@howellschools.com
mailto:blairk@howellschools.com
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Lesson Plan of the Month 

The following lesson plan comes from http://www.microsoft.com/education 
 
Lesson Title: What’s the Real Deal? 
 
Grade Level: ALL GRADE LEVELS, K-4, Middle and High School  
Curriculum Connections: Language Arts, Math, Economics  
SPECIAL CLASS PROJECT: INTELLECTUAL PROPERTY- FOR YOUNG 
CONSUMERS 
Required Software: Microsoft® Word 98/2000, Microsoft® PowerPoint 98/2000, 
Microsoft® Internet Explorer 4.5/5.0, Microsoft® Publisher 98/2000  
 
Microsoft Class Server Learning Activity  
 
What's in this Lesson:  

• Teacher Guide (including How to Begin)  
• Student Activity, Step-by-Step:  

Step A: Find the Fakes  
Step B: Reality Check  
Step C: Fighting the Good Fight  
Step D: Setting the Stage for the Real Deal  

Teacher Guide 
 

Summary:  
 

In today's global marketplace, intellectual property is a hot commodity --- and a concept 
sometimes lost on consumers of all ages. As a result, thieves of intellectual property 
(also known as "pirates") counterfeit a dizzying array of merchandise, from software to 
toys to sneakers. As consumers, your students need to understand what intellectual 
property is and how to safeguard themselves against fakes. This project provides a fun, 
kid-sized introduction to these concepts.  

http://www.microsoft.com/education
http://www.microsoft.com/education/downloads/mctn/classcorner/productivity/cspic/WhatstheRealDeal.lrm


   

   
  

 

 
Counterfeiting affects a wide array of fields your students care about  

Objectives:  
 

To understand the concept of intellectual property and identify ways to overcome piracy 
and counterfeiting.  

Prerequisite Skills:  
 

Basic computer skills and research skills using library and Internet resources.  

Time Allotted:  
 

4 class periods and ongoing  
How to Begin  

1. Call your class together, and ask: Should someone be able to "own" an idea? 
Call for a show of hands, yes or no. Then pose the question this way: What if the 
idea took the form of an invention? A song? A design? What rights should the 
person have who came up with the idea? What protections should there be for 
the original idea?  

2. Introduce the concept of intellectual property in an age-appropriate way:  
• Assign older students to use the dictionary, library resources, and the 

Internet to develop a working definition of intellectual property, with 
examples of what it is and how it's protected in key fields such as fashion 
and technology.  

• Assign younger students to find out who "invented" their favorite toy, 
cartoon, or song. Have them use the library and the Internet to explore 
how their favorites came to be --- and what keeps them unique.  

3. Next, take your students online to one of the Web sites listed on the Student 
Activity page. While they're reading through the warnings about counterfeiting, 
pose these questions: What's so bad about this kind of copying? Who cares 



   
whether what you buy is the real thing or a fake? Expect some heated 
discussion!  

4. Together, develop a list of fields that particularly attract counterfeiters (also 
known as pirates) and where those pirates might sell their wares. Then divide the 
class into small groups for the Student Activity.  

Student Activity 
 

Description:  
 

Is that CD you're spinning "the real deal?" How about beanbag toy you just added to 
your collection or that designer shirt you're wearing? There's a booming market in stolen 
ideas and illegal copies these days. To be a smart shopper, you need to be aware of 
counterfeits, knock-offs, and fakes ---not to mention the modern-day "pirates" who 
create them! With this class project, you'll investigate just how big a problem 
counterfeiting really is, why you should care, and how to fight back.  
 
Step A  
Find the Fakes  
What to do: Piracy takes many different forms in different fields. In this step, your team 
will explore the problem in one particular field.  
 

 
Present the facts you discover about "piracy" in your field of focus.  

1. Gather with the team your teacher has assigned you to, and choose a field of 
focus, such as music, toys, publishing, or software. Discuss the examples of 
counterfeiting you might have personally encountered. Did anyone ever copy a 
favorite software program for you? Ever see Chicago Bulls jerseys so cheap you 
just knew they must be fake? Make a list of the many ways pirates might work in 
your field of focus.  

2. Now go to the library and to the Internet to track down news reports and statistics 
about counterfeiting in your field (see "Real-Deal Web Sites" below for leads). In 
particular, look for information about:  

   
  



   

   
  

• The volume of fake merchandise produced.  
• Where and when these fakes are most likely to be sold (such as online, on 

the street, or through stores).  
• The financial impact on consumers, the industry, and the economy as a 

whole.  
• Common types of piracy in this field and how to spot them.  
• Problems that piracy causes for end-users (such as inflated prices or 

merchandise that doesn't work right).  
• How piracy affects the original creators --- musicians, software 

developers, game designers, and so on.  
• Law enforcement action against fakes. Keep a list of your facts to use in 

the following steps.  
 
 
REAL-DEAL WEB SITES  
 
Microsoft "Be Sure It's Legal" Protection Against Software Piracy  
Beanie Babies  
 
Step B  
Reality Check  
What to do: Translate what you've learned about counterfeiting into a fact sheet 
alerting other kids to the problem. 

1. With your team, discuss your various research results from Step 1. Which 
aspects of piracy in your field will seem most important to kids your age?  

2. Create a fact sheet with Microsoft Word to collect your most compelling facts. 
Rephrase your points in language kids will pay attention to, and add graphics for 
impact.  

3. Share your fact sheet with the class either by printing and distributing it or by 
giving a presentation.  

4. Read or listen to the other groups' facts, and discuss similarities and differences 
among fields when it comes to piracy.  

http://www.microsoft.com/piracy/default.asp
http://www.ty.com/


   

   
  

 
 
Plan a kids' campaign against piracy in your own field of focus.  
 
Step C  
Fighting the Good Fight  
What to do: Build on your work in Step 2 to develop a campaign against piracy in your 
field and others. Here are some ideas you might want to try:  

1. Create a Top 10 list, David Letterman-style. For example, you might want to 
tackle "Top 10 Signs You've Got Bootleg Software" or "Top 10 Ways a Pirated 
Video Can Ruin Your Evening." (Remember, even though the subject is serious, 
your Top 10 list should be funny, because the most important points can 
sometimes be made through humor.) With the help of your classroom computer, 
turn your Top 10 list into a paper handout, a presentation, or a Web page.  

2. Develop a slogan that captures your anti-piracy message in one easy-to-
remember phrase. Your groups should brainstorm several slogans and then pick 
a favorite.  

3. Create anti-piracy reminders that your classmates will see every time they use 
their computers by turning your slogan into "wallpaper" or a screen saver. To do 
this, use Microsoft Publisher or Microsoft PowerPoint to create a catchy layout 
with your slogan and some art, then use the Print Screen or "screen snapshot" 
function on your computer to "take a picture" of your computer screen. You can 
then import this picture into a graphics accessory such as Paint and save it as a 
bitmap, which can then become wallpaper or a screen saver.  

4. Wrap up by thinking of some "big ideas" for getting your anti-piracy message 
across. Imagine that you have a million-dollar budget. What high-impact ideas 
might your group have for reaching young people with an anti-piracy message? 
Would you create a TV ad campaign, build a school Web site, launch a blimp, 
run a contest? Decide together on your three best ideas, and create a 



   
PowerPoint presentation that explains each idea. Explain your strategy and 
include mock-ups of slogans and art. Then present your campaign to the class.  

 

 
 
Step D  
Setting the Stage for the Real Deal  
What to do: Now your class's challenge is to take your anti-piracy message to the world 
outside your school in a way that parents, neighbors, and local business people can 
really understand. A play's the thing! 
 

 
The publicity committee can use Microsoft Publisher to spread the word about 
your anti-piracy plays. Make banners to hang in the hallways, and then create 
invitations, a playbill, and more!  

1. Bring your small groups together as a class. Have each group summarize the 
highlights of what it discovered in Steps 1 - 3, and how group members feel 
about what they learned about piracy in their chosen field. What's the one thing 
they would most want the general public to know about this topic?  

2. Next, each group should make up a five-minute skit dramatizing the problem of 
piracy in its particular field. To keep the skits fresh and fun, try an approach like 
one of the following:  

   
  



   

   
  

• Show the perils of counterfeiting from the point of view of a product: What 
if you were a real Beanie Baby that someone was trying to make illegal 
copies of? How might you play if you were a pirated computer game?  

• Make up a super-heroine (or hero) character called The Piracy Buster, 
and dramatize this character's exploits in fighting fakes. Create list of 
smart tips for consumers to guard against counterfeit merchandise --- and 
then present it as a rapping rhyme.  

• Be sure to credit any music "samples" you use!  
• Take your audience on a tour of a "pirate's den" showing how knock-offs 

are produced (and what dangers they pose for consumers).  
• Use the form of an animal fable --- like those of Aesop --- to explain why 

"making a copy for a friend" can also be a form of piracy.  
3. Your group should show the class a "rough cut" of your skit, and ask for feedback 

on how to improve or clarify it.  
4. Each group should designate a member to the publicity committee to set a date 

or dates for the performance and start getting the word out to families and the 
community.  

5. Each group should also designate one member to be part of a production team to 
write an introduction to the series of skits, arrange the order in which the skits are 
presented, plan for any needed scenery or props, and set a rehearsal schedule 
leading up to opening night.  

6. When the big debut comes, break a leg! (That means "good luck" in theater 
lingo.) You'll already be doing your part to break the piracy trend.  

 
 

***If you have a technology-rich lesson that you would like to share with others, please 
send it to colburnc@howellschools.com no later than the last Monday of the month.  

 

Back to Top of Page 
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 Carole’s Training Corner  
Happy Spring!  

This month I will continue to visit buildings offering training sessions in various applications, including 
Outlook, Word, and Creating Classroom Web Pages and peripheral training in Smart Boards. Also, I have 
begun meeting with teams of teachers at the middle school level to work with them on finding technology 
connections across the curriculum.   

If you have an idea for a technology training session that you would like to have me deliver at your 
school, please let me know via e-mail at colburnc@howellschools.com. I am happy to work with you to 
accommodate your technology training needs as best as I can.  

 Continue to check out my website for training updates: http://www.howellschools.com/~training 

Remember to keep smiling ~Carole ☺ 

 

Back to Top of Page 

 

Tips & Tricks  
The following Tips & Tricks come from: www.wordtipsgold@vitalnews.com/ You can 
have these tips e-mailed to you directly each day by signing up at the above 
mentioned site. 

 
CENTERING A TABLE IN WORD 2000 
 
If you are using Word 2000 or a later version, centering a table is easier than ever 
before: 
 

1. Right-click on the table. Word displays a Context menu. 
2. Choose Table Properties from the Context menu. Word displays the Table 

Properties dialog box. 

   
  

mailto:colburnc@howellschools.com
http://www.howellschools.com/~training
http://wordtipsgold@vitalnews.com/


   

   
  

3. Make sure the Table tab is selected. 
4. Click on Center. 
5. Click on Close. 

 
********************************************************************** 
 
CREATING TABLES WITH SPECIFIC COLUMN WIDTHS IN WORD 2000 
 
Word allows you to easily create tables, but getting your column widths “just so” can be 
challenging, at times. For instance, what if you want a 12-column table with the first two 
columns a certain width, and the rest of the columns sharing the remaining horizontal 
space? 
 
Here’s an easy way to get the desired result: 

1. Create a one-row, three-column table. This one-row table should fill the whole 
width of your document, from margin to margin. 

2. Use the mouse to adjust the width of the first two columns, making them as wide 
as you need. 

3. Place the insertion point in the third column of the table. 
4. Select Split Cells from the Table menu. Word displays the Split Cells dialog box. 
5. Using the Number of Columns control, specify that you want the cell split into 10 

columns. 
6. Click OK. 

 
Your row is now just as you wanted. To create more rows just like it, select the row and 
then choose to insert additional rows above the selected row (Table | Insert | Rows 
Above). After you insert the first row, just press F4 repeatedly until you have created the 
number of desired rows. 
 
 
**
 
******************************************************************** 

DELETING CELLS IN A TABLE IN WORD 2000 
 
Word contains a very powerful table editor that allows you to create very complex 
tables. If desired, you can delete individual cells in your table, even though such an 
action would make the table asymmetrical. To delete a cell, follow these steps: 

1. Position the insertion point in the cell you want to delete. 
2. Choose Delete from the Table menu, then choose Cells. (In Word 97 or before, 

you simply choose Delete Cells from the Table menu.) Word displays the Delete 
Cells dialog box. 

3. Select which way you want the cells to be adjusted. 
4. Click on OK. 

 
********************************************************************** 
 
PRINTING A MULTI-LINE FOOTER IN EXCEL 2000 
 
Excel allows you to create headers and footers that you can use with your workbooks. If 
you want, you can create a multi-line header or footer, as desired. The trick is to 
remember that you cannot press Enter while typing your footer. Instead, to start a new 



   

   
  

line you should hold down the Alt key as you type 0010 on the numeric keypad.  This 
inserts a line-break character in the footer text. 
Another thing to remember when doing footers in this way is that you will need to 
increase the bottom margin on your page setup. If you fail to increase it sufficiently, your 
footer may “overprint” the data in your worksheet, or vice-versa. 
Finally, you must keep in mind that Excel places a limit on the length of your headers 
and footers. The total length of a header or footer cannot exceed 255 characters. If you 
need to create a header or footer that contains more characters, you will need to create 
them differently, without explicitly doing so as a header or footer. 
 
 
********************************************************************* 
 
SELECTING TABS IN DIALOG BOXES IN EXCEL 2000 
 
This definitely isn’t an Excel-only tip, but it can come in handy if you simply don’t want to 
remove your hands from the keyboard. Many of the dialog boxes used in Excel (and 
other Windows programs) utilize the concept of tabs. These look like index cards within 
the dialog box, and are used to organize what could otherwise be a very cluttered 
presentation of information. 
If you want to move from one tab to another, the typical way of doing this is by using the 
mouse. You can, instead, use the keyboard. To move forward through the available 
tabs, simply press Control+Tab. To move backwards, use Shift+Control+Tab. 
 
 
 
 
********************************************************************** 
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Great “Easter/Spring” Links For You to Try…     

 http://www.allcrafts.net/easter.htm 

 http://www.allfreecrafts.com/ 

http://familycrafts.about.com/ 

 http://basketmakers.org/topics/seasonal/easter/easterprintables.htm 

http://www.craftsfortrade.com/ 

Back to Top of Page 

 

For suggestions or questions regarding TECH TIMES, contact: colburnc@howellschools.com 
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